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TO: HEADS OF EXAMINATIONS  

HEADS OF CURRICULUM  

TEACHER UNIONS 

DISTRICT DIRECTORS 

SCHOOL PRINCIPALS 

SUBJECT ADVISORS FOR COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION 

TECHNOLOGY 

GRADE 12 TEACHERS FOR COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION 

TECHNOLOGY IN 2020 

UMALUSI 

 

CIRCULAR E18 OF 2020 

 

PROCEDURES AND GUIDELINES FOR THE CONDUCT OF THE FINAL PRACTICAL EXAMINATIONS IN 

COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION TECHNOLOGY – NATIONAL SENIOR 

CERTIFICATE EXAMINATION: NOVEMBER 2020  

 

1. The procedures that must be adhered to during the conduct of the final practical examinations for Computer 

Applications Technology (CAT) and Information Technology (IT), are brought to the attention of all concerned. 

 

2. Teachers and schools must verify that the software tools they use to implement CAT and/or IT, comply with all 

the content and skills as listed in the Curriculum and Assessment Policy Statement (CAPS) and latest 

Examination Guidelines for CAT and IT. Examination Papers will NOT cater for or be adapted to provide for tools 

that do not comply with the CAPS or Examination Guidelines. (Also refer to point numbers 7 and 8 in this 

circular). 

 

3. Provincial Education Departments (PEDs) are also kindly requested to support schools offering CAT and IT to 

acquire software licenses where applicable, as these are viewed as core Learning and Teaching Support Material 

(LTSM) for CAT and IT. 

 

4. COVID-19 regulations relating to health and safety protocols must be observed at all times. The social 

distancing rule, where candidates must be seated 1.5 metres apart, must be applied. To this end, examination 

centres may have to apply to the Head of Examinations in the province for permission to conduct two sessions or 

more, if necessary. Hand sanitisation and disinfection of the computer centre and computer equipment must take 
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place before, during and after the conduct of the examination. Invigilators, computer technicians and learners 

must wear cloth face masks at all times. 

 

5. You are reminded to refer to the procedures stipulated in Annexure G, Government Gazette 37651 of 2014, of the 

Regulations pertaining to the Conduct, Administration and Management of the National Senior Certificate 

Examination. 

 

6. Prior to the examination Provincial Education Departments (PEDs) must: 

 Ensure that all schools offering CAT and IT have been audited and are ready to conduct the practical 

examinations. Where schools do not have the resources to conduct the examination, PEDs must ensure 

that adequate arrangements have been made for candidates to write at an alternative venue. 

 Have plans in place to provide data files and organise computer laboratories in preparation for the 

examinations. 

 Ensure that they have received data files from the Department of Basic Education (DBE), in all the formats 

compatible to the programs used by all their schools.  

 

7. The November 2020 Computer Applications Technology (CAT) examination makes provision for the following 

software packages:  

 The latest three versions of Microsoft Office will be allowed for examination purposes. For 2020 this will 

be, MS Office 2019 (also known as MS Office 365), MS Office 2016 and MS Office 2013. 

 Notepad ++ or Notepad for the development of web pages. 

 

8. The November 2020 Information Technology examinations provides learner files which are compulsory for use by 

candidates when they do their practical exam. The learner files were prepared and are to be used by candidates 

with the following software packages: 

 Delphi 2010 and upwards 

 MS Access 2010 and upwards 

 

9. PEDs must ensure that all schools offering CAT and IT are audited a month prior to the examinations. The 

checklist for this process (Annexure A) is attached. All PEDs must have the audit completed and reports 

available not later than 25 September 2020.  

 

10. PEDs must consolidate the audit reports to determine the readiness of all centres offering CAT and IT to write the 

2020 NSC Examination. 

 

11. After the consolidation of the audit reports PEDs must submit a declaration to the DBE indicating the outcomes of 

the audit. The declaration form (Annexure B) is attached and should be forwarded to the DBE by 

30 September 2020 for the attention of Ms P Ogunbanjo, telephone 012 357 3909, E-mail: 

Ogunbanjo.P@dbe.gov.za.  

 
12. Prior to the practical examination the CAT/IT educator must refer to ANNEXURE A and ensure that: 

 the regional settings are set to South Africa; 
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 the date and time settings, number settings and currency settings are set correctly; 

 the language is set to English (South Africa), the paper size is set to A4 Portrait and the units of 

measurement is set to centimeters in the word processing application; the Developer tab is activated in the 

word processor application; 

 the Autosave option is set to 5-minute intervals; 

 no communication can take place between candidates on the network/computers; 

 all previous files/folders/documents are removed or isolated; 

 the web browser displays images; 

 the required software for IT (Delphi 2010) is properly installed and tested; 

 the required software for CAT is properly installed and tested. ( i.e. Office 2019 also known as MS Office 

365), or MS Office 2016 or MS Office 2013, Notepad ++ or Notepad)  

 

13. On the day of the practical examination the Chief Invigilator must ensure that: 

 The general instructions contained in the CAT P1 and IT P1 question paper are read out to the candidates before 

giving the candidates their own 10-minute reading time. 

 

14. During the practical examination the Chief Invigilator must ensure that: 

 In addition to the invigilator, an experienced CAT or IT teacher is present during all practical sessions, so 

that he or she can provide assistance ONLY in the event of a technical malfunction 

 All invigilation requirements are strictly adhered to 

 All security processes are carried out under the supervision of the chief invigilator 

 The correct procedures are followed in the case of a power failure or a computer malfunction 

 

15. After the practical examination is completed, the Chief Invigilator must ensure that: 

 Candidates check whether all their files are stored within their examination folders and labelled with their 

correct examination numbers. 

 Candidates complete the Information Sheet (centre number, examination number, application package 

used, e.g. MS Office, version, e.g. Office 2019, web browser used, e.g. Internet Explorer and the file 

names to be marked for each question are completed) and ensure that the information matches their 

examination folders. 

 The teacher retrieves all candidates’ folders via the network or uses a flash disk to copy all folders to one 

central computer or server and checks that every candidate’s file in the folder corresponds with the 

information on the Information Sheet. 

 The teacher writes all the candidates’ folders to compact disks (CD) or digital versatile disks (DVD) to be 

submitted for marking. Two back-up disks (CDs/DVDs) must be written at the same time, one of which 

must be safely stored at the examination centre and the other submitted together with the original to the 

examination section of the province. This must be done under the supervision of the Chief Invigilator. 

 No candidate leaves the examination room until all administrative processes regarding the conduct of the 

practical examinations have been completed. 

 



 
 
 

 

16. The CAT/IT teacher must check the following with regards to the folders saved onto the CD/DVD. 

 The name/label of each candidates’ folder must be the examination number of the candidate. 

 The candidate’s folder is checked to ensure that all files in the folder match the files listed on the 

cover/information sheet.  

 The examination numbers of candidates appear in a sorted numeric order on the CD/DVD. 

 The files in the folders for every candidate must be tested at another computer other than the computer 

used for the copying process. This test is to ensure that the files open successfully.  

 

17. Should candidates’ folders or files be missing, the Chief Invigilator should try to recover the missing or damaged 

folders or files before the CD/DVD is written and submitted it to the district officials. 

 

18. The number of candidate folders stored/copied to each CD/DVD must correlate with the number of candidates 

listed on the mark sheet(s) received. For example, if there are 40 candidates listed on a mark sheet, the 

accompanying CD/DVD must have the folders for all 40 candidates in the same order. If more than one CD/DVD 

has been used, then all the CDs/DVDs must be packed together with the relevant mark sheet(s). 

 

19. IT candidates must check that the code of all units have been printed and then place their printouts in the correct 

order before handing in to the invigilator. Ensure that all pages contain their examination number. 

 

20. The CAT/IT teacher, together with the invigilators, should complete and sign the checklist provided by the 

provincial examination directorate. A sample of the checklist is attached (Annexure C). 

21. Candidates’ files may not be saved on flash disks as the potential of having entire files deleted due to viruses is 

greater with flash disks. PEDs are requested to ensure that schools have access to CD/DVD writers and the 

CAT/IT teacher knows how to write data to a CD/DVD before the examinations. 

 

22. A full report on any technical problems or irregularities that might have occurred during the examinations must be 

submitted to the provincial head office (e.g. missing/damaged files, time lost due to power outages/faulty 

equipment, deviation from instructions, etc.). 

 

23. The following timeframes are suggested for ONLY one and two examination sittings respectively: 

 

ONE SITTING 

 TIME ALLOCATED DURATION 

Seated in computer laboratory  08:30 

Reading time 10 minutes 08:50–09:00 

Paper 1 (Practical) 3 hours 09:00–12:00 

Print (if applicable) and finalise answers, 

collect folders, write CDs/DVDs 

120 minutes (will depend on 

number of candidates) 

12:00–14:00 

 

 



 
 
 

 

TWO SITTINGS 

 

 

24. Candidates may not leave the examination venue until all printing has been completed (applicable to IT) and all 

candidates’ folders and files have been submitted and written to CD/DVDs. 

 

25. Candidates sitting for the second session must report an hour before the end of the first sitting to be escorted to 

the computer room before the start of the second sitting. This will be done after all the candidates from the first 

sitting have left the computer room.  

 

26. If there are any queries regarding the procedures for the conduct of practical examinations, these should be 

directed to the directorate responsible for examinations in the province. 

 

27. Your co-operation in ensuring successful examinations in these subjects is greatly appreciated. 

 

 

 

DR M MABOYA 

DEPUTY DIRECTOR CURRICULUM POLICY, SUPPORT AND MONITORING 

DATE: 08/09/2020 

  DURATION 

 TIME ALLOCATED FIRST SITTING SECOND SITTING 

Seated in computer laboratory  07:30 13:00 

Reading time 10 minutes 07:50–08:00 13:20–13:30 

Paper 1 (Practical) 3 hours 08:00–11:00 13:30–16:30 

Print (if applicable) and finalise 

answers, collect folders, write 

CD/DVDs, clean computers etc. 

120 minutes 11:00–13:00 16:30–18:30 



 
 
 

ANNEXURE A 

 

CERTIFICATION (State of Examination Readiness)  

 

PROCEDURES AND GUIDELINES FOR THE CONDUCT OF THE FINAL PRACTICAL EXAMINATIONS IN 

COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION TECHNOLOGY – NATIONAL SENIOR 

CERTIFICATE: NOVEMBER 2020  

 

(To be completed by the centres and/or PED at least one month before the examination.   

Centres must ensure that all items on this checklist are revisited and are in place TWO days before the examination) 

School name  Tel. No  

District  Fax No.  

EMIS No.  Cell No.  

Examination centre No.  

E-mail address  

Name of chief invigilator  Cell No.  

Name of IT teacher (s) 1 2 

Name of CAT teacher (s) 1 2 

Name of IT technician who will be on standby 
during the examination 

 Cell No.  

1 How many Grade 12 learners will be writing CAT in 2020?  

2 How many Grade 12 learners will be writing IT in 2020?  

3 How many operational computers are available for one examination sitting?  

4 How many Grade 12 CAT class units does your school have?   

5 How many Grade 12 IT class units does your school have?   

6 How many computer centres at your school will be used for the practical examination?  

7 Will the COVID-19 regulations, health and safety protocols be observed? i.e.  

disinfection of the computer centre and computer equipment          hand sanitisation           

wearing of cloth face masks           and social distancing           

 

8 How many examination sittings will be required, one or two? 

If two, have you applied for a second session? 
 

9 Will your centre be writing at a venue other than your own examination centre?    

If so, please state the venue _______________________________________________ 
 

10 What plans are in place in case of a power failure?  

11 Is the computer centre networked?  

12 If the centre is networked, what type of network environment is installed? E.g. peer-to-peer; client-
server. 

 

13 Which operating system is used at your school? E.g. Windows 10   

14 Which software application suite is used? E.g. Microsoft Office 2019  

 

 

 

  

  



 
 
 

15 Indicate with a tick  or a cross × whether each of the following programs have been properly installed 
on the computers in the examination centre 

Word processor         Spreadsheet         Database          Presentations          Notepad ++  

PDF reader                Delphi 2010           

 

16 Have the latest updates/service packs been installed?   

17 Have the regional settings on the computers been set as follows?  

17.1 Region:  South Africa  

17.2 Format:  English (South Africa)  

17.3 Language preferences:   

Short date: yyyy/MM/dd 

Long date: dddd, dd MMMM yyyy 

Short time: e.g. 10:01 AM 

Long time: e.g. 10:01:11 AM 

First day of week: Sunday 

 

 

 

 

 

17.4 Additional settings:  Customise Format:  Numbers Tab 

Decimal symbol: . (full stop . (full stop) 

No. of digits after decimal: 2 

List separator: ,     (comma)  , (comma) 

Measurement system: Metric 

 

 

 

 

17.5 Additional Settings > Customise Format > Currency Tab 

Currency symbol:  R 

Decimal symbol: . (full stop) 

 

 

18 Has the units of measurement in the word processing application been set to centimetres?  

19 Has the Developer Tab in the word processing application been activated?  

20 Has the Ruler in the word processing application been activated?  

21 Have computers been set to save at 5-minute intervals for every application?  

22 Have accessories such as Paint been installed to be available to the candidates?  

23 Which anti-virus program has been installed?  

24 At what intervals is the anti-virus program updated?  

25 Have printer drivers been installed on each computer used for the CAT examination? (It is necessary to 
install and test printers on each computer, even though printing may or may not take place.) 

 

26 Have printers been installed for printing during the IT examination?   

27 Has the Recycle Bin on every computer been emptied/Will it be emptied one day before the 
examinations? 

 

28 Is there a plan in place for emptying the recycle bin on every computer before the 2nd sitting?  

29 Has every computer been cleared of all other files/folders/documents not needed for the examination?  
(The work of other classes must be isolated.) 

 

30 Has the school installed CD/DVD writers?  

31 Has the feature to use flash/memory disks been disabled on all computers for the duration of the 
practical examination? 

 

32 Will access to the internet be blocked/disabled for the duration of the practical examination?  

33 What option will be used to transfer the candidates’ work to the final DVD/CD to be submitted for 
marking? E.g. flash/memory disk; network.  

 

34 Are security systems in place to prevent the computers being stolen or accessed?  

35 Does the school have a maintenance plan/budget in place for the computer centre?  

     

  



 
 
 

CERTIFICATION (State of Examination Readiness) - continued 

 

COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION TECHNOLOGY  

– NATIONAL SENIOR CERTIFICATE: NOVEMBER 2020  

 

All items on ANNEXURE A have been checked.  

(Centres must ensure that all items on this checklist are revisited and are in place TWO days before the examination) 

 
 
 
 

CAT TEACHER 
 

____________________________________________________ 
NAME 
 

___________________________DATE ___________________ 
SIGNATURE 

IT TEACHER 
 

___________________________________________________ 
NAME 
 

___________________________DATE ___________________ 
SIGNATURE 

 

SCHOOL PRINCIPAL 
 

___________________________________________________ 
NAME 
 

___________________________DATE __________________ 
SIGNATURE  

IT TECHNICIAN 
 

__________________________________________________ 
NAME 
 

____________________________DATE _________________ 
SIGNATURE 

 

 School stamp 
 

 
 
 
 
 
 
 
 

 

Verified by  
WARD MANAGER/SUBJECT ADVISOR/DISTRICT EXAMINATIONS & 
ASSESSMENT SERVICES/DISTRICT ICT SERVICES 
 

__________________________________________________ 
NAME 
 

______________________________DATE_______________ 
SIGNATURE  

Comments, if any 
 

_____________________________________________ 
 
_____________________________________________ 
 
_____________________________________________ 
 



 
 
 

ANNEXURE B 

 

 

PROCEDURES AND GUIDELINES FOR THE CONDUCT OF THE FINAL PRACTICAL EXAMINATIONS IN 

COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION TECHNOLOGY – NATIONAL SENIOR 

CERTIFICATE: NOVEMBER 2020  

 

(To be completed by the PEDs submitted to the DBE at least three weeks before the examination) 
 

NAME OF THE PROVINCE: ______________________________________________________ 

 

NAME OF THE HEAD OF PROVINCIAL EXAMINATIONS: _____________________________  

 

 
Yes  No 

 

1. All examination centres where CAT and IT for the November 2020 NSC 

examinations will be examined have been audited. 

    

2. How many examination centres were audited? 
    

3.  Were there any challenges and how were they resolved? 
    

Challenge(s): 

 

 

Solution: 

 

 

4. Do all the examination centres have the necessary software for the conduct 

of the November 2020 examination? 

    

 

 

__________________________________      _____________________ 

HEAD OF PROVINCIALEXAMINATIONS       DATE 



 
 
 

ANNEXURE C 

 
Checklist to be signed and submitted to the examination section of the assessment body with CDs and 
Information Sheets immediately after the CAT/IT practical examinations 
 

 Action/Instruction Yes No 

Learners 

1 All learners labelled their electronic examination folder using their examination numbers   

2 All learners checked that all their files submitted for marking are stored within their 
electronic examination folder 

  

3 All learners checked that the files submitted for marking can open (no shortcuts, no 
damaged or missing files, etc.) 

  

4 All learners completed and submitted the Information Sheet provided   

CAT/IT teachers 

5 CAT/IT teacher checked that all the electronic folders of learners have been 
retrieved/collected from a central computer or individual computers 

  

6 Invigilator(s) collected all the Information Sheets from learners after they were completed 
in full 

  

7 CAT/IT teacher checked that the contents of each electronic folder or file corresponded 
with the information on the learner’s Information Sheet  

  

8 CAT/IT teacher checked that all the learners’ electronic folders or files can open from a 
central computer/folder (no shortcuts, damaged/missing files) 

  

9 CD/DVD, corresponding with mark sheet, was written and contains all the learners’ 
folders and files 

  

10 After the CD/DVD was written, it was checked on a different computer to ensure that ALL 
folders or files submitted could open 

  

11 Two back-up CDs were written, one to be sent together with the original to the PED and 
the second one to be retained in a safe at the examination centre 

  

Chief Invigilator 

12 CDs/DVDs and Information Sheets have been packed according to instructions   

13 A report regarding any technical glitches/irregularities or deviation from instructions has 
been completed and submitted (if applicable) 

  

14 Checklist has been signed and submitted   

 

Centre Number:  __________________  ______________________ 
      DATE 
 
_________________________________  ______________________________ 
CHIEF INVIGILATOR     CAT/IT TEACHER 
 
_________________________________  ______________________________ 
INVIGILATOR 1      INVIGILATOR 2 
 


